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Introduction 

The control and collection software for the research bench top fermentors was made 
to facilitate and automate some general and time consuming tasks. Initially, the 
program was made to collect the process data during fermentation and save these for 
further evaluation in other programs. Soon however, there was also a need for a more 
user friendly program compared to the on-board fermentor control, and the possibility 
of a TCP/IP client connection that significantly reduced the on site time, a factor not 
to be overlooked in a research laboratory. Finally, intelligent control over set points 
seemed an obvious thing to implement. Together, these goals merged to the 
development of the current program. 
To make the program as simple and logical as possible, the amount of choices and 
possibilities are kept at a minimum. Tool tip texts tell you how to manipulate controls 
etc. when the mouse pointer is over a given control for more than a second. The final 
goal is of course to make the present manual useless.  

Computer system requirements 

Windows 95/98/NT/2000/XP, min. Pentium processor 333 MHz (more processor 
power needed for fuzzy logic and neural network modules), min. 64 Mb ram, min. 
200 Mb hard disk space, standard PC serial port (RS-232C), converter for BioStat 
fermentors (RS-232C to RS-422). Serial cable. On Windows 95/98 DCOM95/98 
needs to be installed (free from Microsoft).   

Access Database Version  
Microsoft Access database program (Access 2000 or newer) is needed to manipulate 
the process database, if you want to generate batch reports or print data. The database 
that ships with the Fermentor Control Program is in Access 2000 format. If you want 
to migrate to Access 2000 or higher, open the BioStatDB.mdb file in Access 2000 and 
you will be prompted to save in the new database format. Answer Yes to upgrade 
database. The Fermentor Control Program will recognise both types of format. 
However, you cannot make a replica of the database with Access 2000 as this is not 
compatible with the Fermentor Control Program. This is due to a Microsoft backward 
compatibility policy.  

Installing the Fermentor Control Program 

The program is delivered with an Installation and Setup Wizard . To start the wizard 
run the file called SETUP.exe. After you have downloaded the program unzip the file 
in a temporary directory before running the SETUP.exe file. If you use a NT, 2000, or 
XP system be sure to login as administrator

 

before running the SETUP.exe. The 
installation wizard prompts for an installation directory, and it is recommended that 
you use the default setting. When the installation is finished, you can be asked to 
restart your computer. Although annoying, this is normal Windows behaviour. In 
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some cases, if you have an old Windows 95/98 version, the wizard needs to update 
your system and restart your computer to continue the installation. This will not affect 
anything else.  

A file called St6unst is left in the Fermentor Control Program folder. Do not delete 
this since the un-installer program uses this file if you wish to remove the program.  

Un-installing the Fermentor Control Program 

To un-install the program, use the Add/Remove option found in the windows control 
panel. Press the Add/Remove button and browse to the Fermentor Control Program 
entry. Finally, click remove. You may be asked if you want to remove shared files. If 
so answer NO when prompted. These files are Visual Basic runtime files, which may 
be used by other Visual Basic encoded programs.  

About time and time resolution in windows systems 
Available timer interfaces in Windows have very poor time resolution. This means 
that the time points are not precisely spaced with the given sample rate (30 sec.), and 
is partly an effect of event based programming. Nevertheless, to communicate with 
the fermentor a millisecond resolution is necessary and therefore a special function is 
used to give this resolution.   

IMPORTANT:  One drawback is that you have to restart your computer every 23 
days to reset the function counter.

 

The best thing to do is to restart the computer 
before every new fermentation run, but that will probably be the normal case anyway.  

About decimal symbol in windows systems 
Due to a bug in Microsoft Visual Studio the handling of the decimal symbol is not 
easily accomplished. The Fermentor Control Program will try to follow the 
international setting on your computer. To know which decimal symbol to use in files 
used by the program, have a look at the output files generated by the program and use 
the same in your own input files (*.MF fuzzy logic, profile, and neural network 
training files). Also have a look at the text in input boxes, the correct decimal symbols 
for your system is given there.  

If you see incorrect data being sampled, try to set your international settings to 
English. You can do this by going into Control Panel, and then click on International. 
In the first panel select English, then restart the computer.  

Fermentor settings 

BioStat Fermentor 
Before you start the Fermentor Control host program the fermentor has to be set up 
for host connection. To do this, go into the MAINTENANCE menu on the fermentor 
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and step down to the HOST setup. To alter the settings enter the 2-digit password to 
access the interface parameters. Then set these as indicated below.    

ADR:   1   
SPEED: 9600   
DATA: 7   
STOP:  1   
PARTY: EVEN

   

Finally, press the remote button to ON. The fermentor is now ready to communicate 
with the host computer.  

During the fermentation run you can manually manipulate the settings on the 
fermentor by setting the remote button to OFF. While doing this you are unable to use 
the computer as controller and the host program will prompt you to set it to ON again. 
However, data collection will continue, and the Fermentor Control Program will 
update its controls to match the manually entered changes.  

Pump setting  
The current version of the Fermentor Control Program only supports anti-foam for 
substrate pump 1 and substrate addition for substrate pump 2. Therefore, pumps have 
to be set to apply with this before the control program is started. Please consult with 
the operating manual for the fermentor  

Communication port setting 
The connection between the BioStat fermentor and the host computer goes trough the 
standard PC serial port and an RS-232C to RS-422 signal converter. The converter 
can be bought in most PC or electronic stores for approximately 100$. Please refer to 
fermentor hardware user manual and the Fermentor Control Program homepage for 
instructions on wiring or see appendix. When the control program is started, it looks 
for the serial communication port to which the fermentor is attached. The default port 
number is 2, as Comm port 1 is usually used for the mouse. If Comm port 2 is not 
available you will be prompted for another port number (1 to 8). If the given port is 
free then program continues to search for the fermentor and you can see in the status 
bar when the host program found it (See also: Status bar). If the status bar continues 
to display the fermentor is OFF then check that the remote button is ON, the cable is 
plugged to the right Comm port, and that the converter is working. Restart the 
program to alter the Comm port number if necessary.  

Communication test tool  
If you are experiencing problems in connecting the fermentor to the PC, then you can 
use the TestComm test tool to check the connection. Download the tool from 
FoxyLogic.com, place it in the Fermentor Control Program folder, and run the 
program with the fermentor. First the tool looks for available and free serial ports on 
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your computer. Then you select the port, which the converter is attached to, and press 
the Test Connection button. Every 2 seconds the program sends a telegram to the 
fermentor and checks the returned telegram. If the fermentor is correctly setup, a text 
message will tell you so. If no connection is detected then check you cabling and 
converter. As a last resort you can contact me by Email: support@foxylogic.com, but 
only if you attach the Run.log and Error.log generated by the TestComm tool.  

BioFlo Fermentors 
To setup the communication between a computer and the fermentor a protocol has to 
be used.   

BioFlo III, 2000, and 3000 fermentors: To enable the right type of protocol you 
need to open the back of your fermentor and change the settings of the micro-switch 
S1 as follows (Consult you instrument manual to locate the switch):  

Settings of switch 1 (S1) on the fermentor control board 
1. S1-1 and S1-2 are used for setting the baud rate: 

Baud Rate S1-1  S1-2 
  9600  OFF OFF (factory setting) 

2. S1-3 is used for setting the parity check: 
Parity  S1-3 
Even  ON 

3. S1-4 is used for setting mode: 
Mode  S1-4 
non-multidrop OFF 

4. S1-5, S1-6, S1-7, S1-8 are used for setting unit number: 
Unit #  S1-5 S1-6 S1-7 S1-8 
0  ON ON ON ON (factory setting)  

Settings of the micro-switch S2 as follows (Consult you instrument manual to locate 
the switch): 

1.  S2-1 S2-2 S2-3 S2-4   
ON ON ON ON (factory setting) 

BioFlo 110 Fermentor: 
For the BioFlo 110 fermentor you need a cable like shown below:  

DB9 (PC)        DB25(BioFlo 110) 
   2 ---------------- 2 
   3 ---------------- 3 
   5 ---------------- 7  

On the BioFlo 110 box set the Base Address to "Zero" on the fermentor (see Manual 
page 70; 5.3.3) and select AFS mode as protocol. Set the subunit addresses to unit 1
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Loop and pump settings for BioFlo 2000/3000/4000 and  

Before you start the Fermentor Control Program you may need to manually setup the 
use of pumps on the BioFlo fermentor in the right order. Thus, Acid, Base, Antifoam, 
and Substrate needs to use the indicated pumps as shown below. If not, the values and 
setpoint on the fermentor are not recognised properly by the Fermentor Control 
Program:   

Feed 1 for Acid    
Feed 2 for Base   

Feed 3 for Antifoam   
Feed 4 for Substrate  

Finally, when you start the Fermentor Control Program for the first time you need to 
change the fermentor type from the default BioStat fermentor to a BioFlo fermentor 
type. This is done in the Options menu. 
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The main control window 

The main control window allows you to control and set up the fermentor before and 
during a run. The menu bar contains the functions and setup programs needed to start, 
stop, save data, enable TCP/IP remote connection to the client program, edit profiles, 
and to control the fuzzy logic and software sensor modules. Some of these menus are 
only available during time when a batch is running. All batch and process data is 
stored in a Access database also.  

Control window  
The control panel is 
where you can 
manipulate set points on 
the fermentor. As shown 
in the figure, using the 
graphical sliders and 
ON/OFF buttons above 
them does this. For 
example, to set agitation 
to ON click the OFF 
button, which then shifts 
to AUTO. A tool tip text 
also tells you how to 
change it. The slider 
below is enabled and with the mouse or keyboard (page up/page down/arrows) you 
can set the new set point. Below the slider there is a numerical display that indicates 
the current set point. When you change to the given set point, the number turns red. 
Once accepted by the fermentor it turns green again. Be aware that this can take up to 
30 seconds. The value is set immediately, but the program only checks all actual set 
points every 30 seconds.  

A special case is when the pO2 level is set. The host program uses agitation to control 
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the level of dissolved oxygen in the fermentation tank. When you click the pO2' 
button the stirr-slider is disabled and the stirr-button displays the text pO2 Casc , 
meaning that oxygen cascade controls the agitation. When you turn off the pO2 again, 
the stirr control is enabled and left at the last setpoint given by the pO2 cascade 
control.   

The current version of the Fermentor Control Program only supports addition of anti-
foam by the substrate pump 1. Therefore no slider control is available for this pump. 
It has to be setup manually on the fermentor prior to a run. The actions of the pump 
are being logged during the run and are stored in the collection data file.  

Time panel 
This is an information only panel. When the program is started 
only the current date and time are shown. Once you initiate the 
fermentation run, the start date and time is registered. These are 
saved in the log files and the collection data file together with the 
user name. At the top a timer is started displaying the elapsed 
fermentation time. The profile module as reference timer uses this 
counter.    

Status bar  

The status bar gives you an up-to-date view of the state of several interfaces. First, it 
tells you whether the TCP/IP is open, closed, or listening (See TCP/IP client control). 
It also tells you what IP-number the host computer has. And it shows you if the 
connection to the fermentor is on or off, and finally, you can see the current user 
logged in and the name of the batch owner. Holding the mouse pointer over each box 
in the status bar a tool tip texts will be displayed to tell you which is what.         



Fermentor Control Program, manual version released 15 February, 2005 

FoxyLogic, PhD, MSc Mikkel Holmen Andersen, Aarhus, Denmark 
Email: info@FoxyLogic.com. Program homepage: www.FoxyLogic.com

  

12

 
The database system 

Starting from version 4.0 a new database system has been introduced. The program 
utilises the widely used Microsoft Access database for the storage of user, batch, and 
process data. This data is then available for historical investigation using up to date 
database technology. Furthermore, all data are easily available for the software 
substrate sensor during training (a future automatic feature).  

The database is built up of three sub-databases: a user, 
batch, and a process database. These are linked 
together by unique UserIDs and RunIDs to form what 
is called a relational database system.    

When the program is started you will have to login to 
the database. This is done by selecting the 
User/Batch menu and selecting User LogOn . A 

window as below will be shown. You can create a 
new user profile by clicking Create New User or 
simply log in as default user (Password: 111). New 
users are by default set to have Batch Owner access 
rights.   
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Once a user is logged in to the database, the menus Batch Start/Stop and View 
Batch Data becomes available. To start a batch select the Batch Start/Stop submenu 
Start Batch Run . Likewise, stopping of a batch is done by selecting End Batch 

Run . In the View Batch Data menu you can choose to display the currently running 
batch data as well as old batch data. You are only allowed to see and edit data for 
which you are logged in. The window shown below allows you to display and edit 
batch information such as stain, media, and product information. Only the specific 
Batch Owner can stop and edit the batch data. In this window the Run log is also 

shown.  

You have the possibility to synchronize your fermentations to a certain time point for 
example at inoculation or when induction of recombinant protein is induced. Press the 
synchronize button and the Batch Age counter in the Batch information window with 
reset and count from that moment. You are only allowed to set the synchronization 
time once during a batch.  

By clicking the View Process Data button you can see the batch specific process 
data in table format as shown in the figure below. Both collected, derived, and offline 
data can be edited for the current and finished batches.      
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Three offline data sets are currently available named: OFF-LINE DATA1, OFF-LINE 
DATA2, OFF-LINE DATA3. In the Options menu you can change these names by 
names that reflect better the data type you are entering (See Option Menu below).  

To enter or edit offline data, click on the Edit Off-line Data button. This will disable 
the updating of the process data table to give time to edit the data points. Once you are 
done, click on the same button and the data will be updated to the database and data 
collected meanwhile will be displayed.  

At any time you can export processes data to a file in XML file format. This format is 
widely accepted by other software.  

Database Tools 
In the File menu several database tools are found. The other 3 are all for maintaining 
the database. These functions are only available when the program has just been 
started, and for users with Administrator access rights.  

Extract Training Data  will be discussed below in the software sensor section.  

Compact Database will clean up the database and results in a small and faster 
database file. You should perform this operation every five fermentation runs.  

Backup Database

 

simply takes a hard copy of the BioStatDB.mdb file and stores it 
at the place you select.  

New Database is the most time consuming tasks and is only recommended when 
the database is getting very large. The Access database has an upper size limit of 2Gb. 
Therefore you need to export process data out of the database and store this in another 
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database. The New Database performs this task. It accumulates new user, batch, and 
process data in the BioStatDBBackup.mdb files and deletes process data from the 
BioStatDB.mdb file. This process is time-consuming and could be left to run during 
the night. For example, it takes 20 minutes to move data from four 5-day 
fermentations. In the Main Control Window , a progress bar will show you how 
much data have been moved (0  100%).   

When the BioStatDBBackup.mdb gets near the 2 Gb size limit, this in turn is backed-
up automatically and given a date extension to the file name (ddmmyy, e.g. 
BioStatDBBackup010102.mdb). A new accumulative BioStatDBBackup.mdb file is 
then created. A copy of the old User and Batch information is kept in the 
BioStatDB.mdb file to provide data consistency (unique User and Run ID s). This 
means that you can later combine all BioStatDBBackupddmmyy.mdb database files 
into one big historian database, if you have access to MS/SQL Server, MySQL, or 
similar programs that can handle very big databases.   

Administrator Tool 
Like the database tools, this function is only available when the program has just been 
started. After the first log in access is disabled. The tool is used to control user access 
rights to the program.  

There are 3 levels of user-rights, each with different access rights associated with 
them.  

Program Functions Batch Observer Batch Owner Administrator 
Start/Stop Batch 

   

View Batch/Process Data 

   

Edit Batch/Process Data 

   

Changes Process Setpoints 

   

Profile Editor Settings 

   

Fuzzy Logic Settings 

   

Substrate Sensor Settings 

   

Internet server Settings 

   

Change Options 

   

Database Tools 

   

Edit User Rights 

    

Selecting the Administrator Tool menu will result in a prompt for a password. This 
password can only be obtained from me by sending a request by Email. Passwords 
will only be given to persons who have registered with a valid Email address, when 
downloading the Fermentor Control Program.  

After entering the password you will be shown a window in which all users in the 
database are listed. A selection panel with Batch Observer , Batch Owner , and 
Administrator options are shown to the right. Select the user then the access rights 
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and click Set User Rights .      

Historian Database Layout        

New Database

 

BioStatDB.mdb 

BioStatDBBackup.mdb 

BioStatDBBackup.mdb 
BioStatDBBackup.mdb 

BioStatDBBackup010102.mdb

 

BioStatDB.mdb 

Delete Process Data 

Copy User, Batch 
and Process Data

 

New Database

 

If size ~2 Gb 
Copy Database 
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The graph window 

In this window the collected data are shown in a simple XY-scatter plot. Checking the 
corresponding check box beside the graph display chooses the different graphs of 
process data. All graphs are shown as default. On the other side the graph scale is 
shown. For simplicity it is divided into two different scales and you can change 
between them by clicking on the scale. A tool tip text also tells you how to change it. 
Below the graph selection box there is a window which shows the position of the 
mouse pointer when this over the graph area. If the pointer is over a data point the 
value of that point is shown together with the time of it.  

In the menu of the graph control, you can change the layout of the graph window. The 
scaling of the volume and the time axis can be changed. Furthermore, you set how 
many of the obtained data point you wish to see. Finally, you can chose to print the 
displayed graph at any point during the fermentation run. Only the curves shown in 
the graph will be printed on the default Windows printer. The resolution is not terrific 
and the option is only intended for preliminary analyses and simple data inspection, 
whereas the saved data file can be used in any spreadsheet program most of which 
have excellent graph options.   

From version 3.0 of the program, an extra graph has been added. This graph shows 
the predicted substrate concentration. By using the software substrate sensor module, 
current process values are used to predict the substrate concentration in the fermentor 
broth (See Software Substrate Sensor).  If the module is in use, you can enable the 
graph. The data are shown in an insert graph with a time window of 60 minutes. The 
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graph is self-scaling. Use this graph to inspect the correctness of the software 
substrate sensor. If you see large differences sample more training data for this 
fermentation phase.   

Synoptic process data window 

A window showing all recent process data in a synoptic display as shown below has 
been added. The latter window is for information only. The status of the pumps and 
volume levels are shown. The predicted substrate concentration is only shown when 
the software sensor is turned ON.  

The levels of liquid in the fermentor tank and supply tanks are changing to reflect the 
process data sampled. For this to work best, you have to enter data for your specific 
fermentor setup. This only has to be done once in the Vessel and Supply Tank 
settings found in the Set Options menu.     
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Profiles module 

The profile module is a significant improvement of the Fermentor Control Program. 
With this control you can design timed programs, by which the fermentor should 
follow. Since you are not around 24 hours a day, this control will let you change 
setting points at any time during a fermentation run. The elapsed fermentation time is 
used as reference time. Profiles are turned on by selecting the profile enabled entry 
point in the Profiles menu.   

Profile editor  
Profiles can be created when the fermentor is running. By selecting the Edit Profile 
menu point a window as seen below is opened. Here you select, the time when you 
want the change to take place, the control you want to change, and finally you set the 
set point. When this is done, click the Add Entry button and the new entry will 
appear on the list. In the file menu you can both save profiles and load old once.  If a 
wrong action is in the list, you simply click on the entry in the list and then press the 
Delete Entry button.  

Entries that have been executed are shown in green, pending once are red. If you load 
a profile during a run, actions with time points less that the current elapsed 
fermentation time will be ignored and shown in green. All actions made by the profile 
control are logged in the batch database and the RUN.log file.  
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Fuzzy logic control module 

Fuzzy logic control is equivalent to have computers reason like humans do, just much 
faster. Normally, when we think of computers making decisions, the output would be 
true or false. However, fuzzy logic is a way of letting the computer say little, big, 
bigger, not so big, and so forth, and have an output decided upon from these vague 
inputs.  

Fuzzy logic has some strength over conventional control algorithms like for example 
Proportional-Integral-Derivative (PID) control. Often biological systems are non-
linear, difficult, or impossible to model mathematically. However, fuzzy logic is 
empirically based and model-free thus opens doors for control systems that would 
normally be deemed unfeasible for automation. Furthermore, fuzzy logic is very 
robust and does not need precise and noise-free inputs to generate usable outputs. 
Finally, fuzzy logic is not conceptionaly difficult to understand, and it can easily be 
modified and fine-tuned during operation.  

Essentially, fuzzy logic revolves around a rule base made of simple, plain-language if 
X is A and Y is B then Z is C rules. The rules describes the response to a number of 
inputs (X and Y), which could be pO2, pH etc., and A and B are linguistic variables 
representing the input values. Although words like large negative, small, and hot are 
imprecise, they are descriptive of what must actually happen. So instead of making 
ridged control algorithm, a small number of rules offer a much more flexible control 
without any mathematical model of the system. This is what experts do when they 
assist in controlling ill-described systems; by reasoning from prior experience and act 
accordingly to it.  

There are several very good tutorials and bibliographies on the Internet, if you are 
interested in learning more about fuzzy logic. See the program homepage for more 
information (www.FoxyLogic.com).  

Fuzzy logic rule matrix  
So what to do to get the fuzzy logic controller running? First of all, it has to be 
decided, which parameters can be used for control. For the lab bench fermentors there 
is little to decide however, since the only thing you have direct control over is 
addition of substrate. The other parameters are in the hands of the hardware embedded 
PID control, which does a good job of it. But the collected data can be used as input 
for the controller that is pO2, dpO2, and substrate set point. In the future other 
parameters may be added, as they are demanded.   

Thus, to setup the fuzzy logic control, a rule database made of if X is A and Y is B then 
Z is C rules is needed (A: pO2, B: dpO2 or substrate setpoint, C: substrate setpoint 
output). To gather and organise knowledge about the relationship between these 

http://www.FoxyLogic.com
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inputs and corresponding output linguistic values, a rule matrix is usually used. By 
filling in control words like: Positive Large (PL), Negative Medium (NM), and Zero 
(ZE) the controller knows what to do when a rule is applicable.   

A rule matrix is organised as follows: 

If X is A and Y is B then Z is C 

 

Y 

 

X 

 

B 

 

A Z(C) 

    

Substrate Feed Rate 

     

Very Low Low Ok High Very High 

 

Very Low NS NM NM NL NL 

pO2 Low NS NS NS NS NM 

 

Ok PM PS PS ZE NS 

 

High PM PM PS ZE NM 

 

Very High PL PL PM NS NL 

Very Low (VL), Low (L), Ok, High (H), Very High (VH) and Negative Large (NL), Negative Medium (NM), 
Zero (ZE), Positive Small (PS), Positive Medium (PM), Positive Large (PL).    

Take RULE 3

 

from the figure found on next page: If pO2 is Low and Substrate Feed 
Rate is High then Substrate Feed  Rate is Negative Small. Or in short: If pO2 is L 
and Substrate is H then Substrate Feed Rate is NS.  

As you can see it is easy to use the rule matrix to make the rulebase file for the 
controller program. The above matrix will yield 25 rules, which should be entered 
into the RuleSub.fuz file. Likewise, the rules for the RuledpO2.Fuz and 
RuleSoftSub.Fuz files can be created by filling in a rule matrix for each case. The 
change in Substrate Feed Rate is determined by the values given in the dSub.MF file.  

Some work must be put into adjusting the values given in controller files, however 
only the rule files need essential editing to fit your expression system:  

Sub.MF  Substrate Member Function, converts substrate setpoint to 
fuzzy value. 

pO2.MF  pO2 Member Function, converts pOxygen setpoint to fuzzy 
value.   

dpO2.MF  dpO2 Member Function, converts dpOxygen setpoint to fuzzy 
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value.    

pH.MF   pH Member Function, converts pH setpoint to fuzzy value.   

dpH.MF  dpH Member Function, converts dpH setpoint to fuzzy value.   

SoftSub.MF  Member Function, converts predicted substrate concentration to 
fuzzy value.   

dSub.MF  dSub Member Function, converts fuzzy value to substrate 
setpoint.  

RuleSub.FUZ  Rules for pO2 and dSub substrate control(DO-stat).   

RuledpO2.FUZ Rules for pO2 and dpO2 substrate control (DO-stat).   

RulepH.FUZ  Rules for pH and dpH substrate control (pH-stat).   

RuleSoftSub.FUZ Rules for [Sub] and Sub substrate control. 
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A schematic drawing of how the controller is working is shown above.  

The file layout is tabulated and every line starting with an asterisk (*) is ignored. 
More information about values and file layout is given in the legend of the above files 
(see Appendix). 

 

Running the fuzzy logic module  
When you turn on the fuzzy logic control a green ON will show in the 
Fuzzy Control window between the pO2 and substrate slider controls. 

You can follow the input data (pO2, current feed rate, and dpO2) and 
the output (change in feed rate). All input and output data, and actions 
made by the control is logged in the fuzzy.log file (see log files).  

In the submenu of the under the Fuzzy Logic menu you can decide 
how often the controller should run. Furthermore, you can turn on and 
off the different types of fuzzy logic control to run your fermentor in 
DO-stat mode or in pH-stat mode.  
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Under the Fuzzy Logic menu you can select which functions should be running and 
how often. You can also start a test run where the fuzzy logic controller just saves 
data in the fuzzy.log file. Turning on the test run, no changes to the substrate feed rate 
is done, so you can see and adjust the performance for the controller without losing 
your fermentation. If you make changes to the control files (dpO2.mf, dSub.mf etc) or 
the rule files, you can reset and reload the control with the new settings by selecting 
the menu Reset/Reload .  

The software substrate sensor 

Biological systems are difficult to model largely due to the inherent non-linearity of 
such systems. However, neural networks can help users to describe and model 
phenomena that are too complex for analytical methods or empirical rules. Neural 
networks can efficiently be used to forecast process values in fermentation processes, 
since they are able to map/describe non-linear functions. In the case of fermentation 
processes, neural networks are for instance able to forecast the substrate concentration 
on the basis of inputs such as culture volume, pH, pO2, and current substrate feed rate.   

Neural networks are used in large-scale fermentation systems to aid the supervisor in 
keeping the batch in good shape thus maximising the product output. Since this is also 
the main goal in the research laboratories, a neural network software sensor module 
has been incorporated into the Fermentor Control Program. The idea behind this 
addition is to enable researcher to predict the available substrate concentration and 
also to have a tool to validate off-line substrate concentration measurements. As many 
expression systems are using the fed substrate to either induce or control the 
expression of recombinant protein or product, it is of importance to know the free 
concentration of the substrate. Too low a substrate concentration leads to low 
expression, and when high overflow metabolism can inhibit cell growth and thus 
product production. The output from the software sensor can be used as input for the 
fuzzy logic control module such that the optimum substrate concentration in the 
fermentation tank is maintained.  

One of the initial steps towards a successfully working neural network software 
sensor is to decide on the network layout. On the basis of information from many 
different sources, a two layered fully connected backpropagation network was chosen: 
besides input units, one hidden layer and an output layer are forming the sensor 
network. A sigmoid activation function is used and a threshold term is added to the 
neuron output function preventing the network to be trapped in a local minimum. 
Input data are rescaled to values within a range of -1 to 1 and output data between 0.1 
and 0.9. Currently 7 inputs are being used as input for the software sensor as these 
parameters can be derived from data collected by the main fermentor control program. 
The single output from the net is giving the estimated substrate concentration.   
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Sampling Training Data 

To successfully implement the neural network software substrate sensor several things 
will have to be done. Firstly, before a neural network can be used in process control, 
the network needs to be trained with historical process data obtained from previous 
fermentation runs. Thus data from previous fermentation or new data has to be 
prepared in files to be used for neural network training. From the Fermentor Control 
Program, it is possible to collect the training data automatically. Firstly, under the 
Software Sensor menu, there is an entry called Sample Training Data . Using this 

function, you are prompted to enter the off-line measured substrate concentration 
corresponding to the time point the sample was taken. Off-line measurements could 
easily been made with on of the many kits available for determine e.g. glucose 
concentration. This information is together with seven other parameters added to two 
training data files (See appendix) and to the process database.   

After the collection of enough data has been completed (see below), you can extract 
and save the training data sets automatically. In the File menu under Database 
Tools there is a menu called Extract Training Data . A window will be shown with 
all extracted data. Select Save Training Data and you will be prompted twice to give 
file names for the two training files (Input and Output data). These two files are then 
ready for the Sensor Training tool. Furthermore, a representative data set can be 
removed from the sampled data from above, which will be put into two validation 
files (See below). Every ~10th sampled datapoint is selected for validation during 
neural network training.  

You can also use the backup files called TrainingDataIn.log and TrainingDataOut.log. 
You need to edit these files in a text editor and add a line to the top. This line is telling 
the training tool how many data points and input/output data there are in the file (See 
appendix for file layout). The file layout of these files should be identical to the 
training data files saved by the Extract Training Data program discussed above.  

How much data is needed?  
There is no easy way to answer this question. But to train a neural network for use in 
process value forecasting, as a rule of thumb you need at least 5 times the number of 
weights in the net (Number of inputs * number of hidden units + number of hidden 
units * number of outputs). To calculate the number of hidden units use a general rule 
of: (Number of inputs + outputs) * (2/3). This should give: 7 inputs, 6 hidden units, 
and 1 output unit. Therefore, for training you need at least 250 data points containing 
process values and measured substrate concentration. It is advisable to try different 
numbers of hidden units to obtain the best results.  

Besides the training data set you need to have a smaller validation data set which 
represents the training data set. This set is not used for training but to check the 
network during training. A central goal during network training is not to memorise the 
training data, but rather to model the underlying generator of the data (the 
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fermentation process). A problem with neural nets is that they will fit almost any data 
set giving enough training. Therefore, noise and errors in the data set are fitted as well 
if training is prolonged. To avoid overfitting , the validation set is used to check 
whether the network is overtrained or needs more training cycles.  

The sensor training tool  
The training tool is installed together with the Fermentor Control Program and is 
found in the program folder. To begin with you chose to create a new neural network 
by selecting the New Network in the File menu. In the Initialise Neural Network 
window you chose the number of hidden neurons and press Initialise Network . You 
can now see the network by selecting the View Network in the View menu. After 
this enter the Training menu and select the Load Training Data menu to tell the 
program where to find the four training file created above (input training data, output 
training data, input validation data, output validation data). Finally, select the Train 
Neural Network to begin training.   

The window that pops up is the Neural Network Training Control and in this 
window you can set the various training parameters as well as test the network 
performance with data you enter. Once you click the Start Training button, a graph 
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plotting the error of the training network in predicting the output of the training data 
and the validation data is depicted. It is important to follow these curves as they tell 
you when to stop training.  

Validation is done by following the root-mean-square (RMS) error on the substrate 
concentration predictions (Subpredicted - Subreal). Thus, the trained network tries to 
predict the substrate concentration from new data in the validation data set, and the 
output value is compared to the real value in the same data set. Once the sum of RMS 
errors on the validation data set starts to increase during training, the network is 
sufficiently trained and the program will save that network for later evaluation. In the 
sensor training tool that follows the fermentor program, a graph shows the RMS 
errors of the training data and the validation data set. On the graph, F1 ..Fn shows the 
points during training where the network has been saved. Stop training when the RMS 
error on the validation data set increases slowly.  

Using the substrate sensor  
The trained neural network file sensor.nnf will have to be placed in the Fermentor 
Control Program folder. Once a fermentation run has been started you can turn on the 
sensor and watch the displayed results in the fermentation tank and the graph 
windows. Possible uses of the predicted substrate concentration are to validate other 
sensor readings such as off-line substrate measurements.  

If you decide that the performance of the software sensor is good, you can use the 
fuzzy logic control module to adjust the substrate feed rate to optimise product 
formation. The neural network output must be integrated with the rule-based fuzzy 
logic module, since, as stated above, no liable model exists by which the predicted 
substrate concentration can be used to reach the desired concentration.  

Alternatively, you can use the software sensor to help identifying different phases of 
the fermentation process. Instead of collecting substrate concentration data point you 
can enter an unique integer for each phase and train the neural network with that. The 
network will predict the current phase the fermentation is in.    
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Current Input Parameters   

The currently supported inputs for the software substrate sensor are:  

 
Feed Rate (% pump action) (time = t) 

 
Volume Substrate feed (mL) 

 

Total culture volume (mL) 

 

Offset pO2 (pO2 setpoint - pO2 current) 

 

pO2 (last 5 min.) 

 

Offset pH (pHsetpoint - pHcurrent) 

 

Previous substrate concentration (t-1)  

For training the measured substrate concentration at time = t is needed. The file layout 
of the training data files is tabulated and lines starting with an asterisk are ignored. 
These files can be generated automatically by the Fermentor Control Program. More 
information about values and file layout is given in the legend of the above files (see 
manual Appendix). 

pH Stat 

The pH-Stat is a powerful tool to control a simple fed-batch feeding strategy. When 
cells are consuming a substrate by-products are produced, and these will affect the pH 
in the fermentation tank, which normally will decrease. By adding new substrate 
mixed with e.g. NH4OH pH will change. 

To start the pH-Stat tick the ON field in the low part of the window. If you the pH 
Trigger Value

 

to the pH you want in the culture, and turn of the normal pH control, 
the substrate pump will run for a certain time, pulse interval, with a certain speed, 
Substrate Setpoint. Select whether you need substrate added when the pH is below or 
above the trigger value (this depends on the acid or base in the substrate mixture). 
You can control the growth rate of the culture by correctly setting the setpoints.  
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Probing Feeding Control Module 

The probing feeding controller is an extreme controller . It will try to push the 
maximum out of the fermentor by maximising the feeding rate. The rationale behind 
the probing feeding controller is to take advantage of the characteristic saturation in 
the respiratory system, which occurs when overflow metabolism is present. 

As shown in the above figure the feed rate is increased at timed intervals and the 
effect on the dissolved oxygen (DO) is followed. If the culture can utilise the 
additional substrate aerobically, a drop in the DO is seen. On the other hand if the 
respiratory system is saturated, the addition of more substrate will not result in a 
decrease in the DO, but instead by-product metabolites are formed that can inhibited 
product formation and cell growth.  

During the feeding pulse the probing controller turns off the dissolved oxygen 
controller so that the stirrer speed is kept constant. This will allow the detection of the 
DO drop. Once the pulse interval has ended the DO is again controlled using the 
agitation speed. This guarantees aerobic conditions and ensures that the oxygen level 
has the same value at every pulse start. 

For a further detailed look for the work of Mats Åkesson et al.: 

M. Åkesson et al., On-Line Detection of Acetate Formation in Escherichia coli 
Cultures Using Dissolved Oxygen Responses to Feed Transients , Biotechnology and 
Bioengineering, vol. 64,  September 5, 1999. 

M. Åkesson, Probing Control of Glucose Feeding in Escherichia coli Cultivations , 
PhD thesis, 1999. 
M. Åkesson and P. Hagander, A simplified probing controller for glucose feeding in 
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escherichia coli cultivations , In IEEE Conference on Decision and Control, Sydney, 
Australia, 2000. 
M. Åkesson, P. Hagander, and J. P. Axelsson, An improved probing controller for 
substrate feeding in fedbatch cultures of e. coli: simulations and experiments , In 
Computer Applications in Biotechnology, Quebec, Canada, 2001. 

  

Scripting Module 

Adding a scripting feature to the Fermentor Control Program greatly increases your 
possibilities when adapting the program to your needs. You have full control over all 
setpoints and you can make calculations that are then passed back to the Fermentor 
Control Program as a new setpoint or an off-line value. The below table shows you 
which values you can use in the script and which you can return to the Fermentor 
Control Program.  

Variable Read 
Variable 

Write to 
Variable Control Variable Type 

Time (EFT) Yes No No Value (minutes) 

Temperature Yes No On/Off/Setpoint Value (0 or 1, 0-150C) 

Agitation Yes No On/Off/Setpoint Value (0 or 1, 0 -1500 rpm) 

pH Yes No On/Off/Setpoint Value (0 or 1, 2 - 12) 

pO2 Yes No On/Off/Setpoint Value (0 or 1, 0-100%) 

Substrate Yes No On/Off/Setpoint Value (0 or 1, 0-100%) 

Foam Yes No On/Off Value (0 or 1) 

Acid Yes No No Value (0-10000 mL) 

Base Yes No No Value (0-10000 mL) 

Predicted [Sub] Yes No No Value 

dpO2 Yes No No Value 

OffLine1, OffLine2, OffLine3 No Yes No Value 
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The scripting language is Visual Basic for Applications (VBA) and is used in all 
Microsoft products. For further information on the scripting language look at the vast 
amount of tutorial on the internet.  

To run a script, you need to load it first and then enable scripting in the Main window. 
There is a button for error checking the script before you enable it. Any error in the 
script will be highlighted in red. Only one error at a time can be detected, thus if you 
have an error in your script the correct it and do error checking again before you 
enable the script  

Alarm module 

The alarm module can be used to control the way you log messages and to raise 
alarms during a fermentation run. If you need to know when the maximum agitation 
speed is reached you can set a maximum speed and get the exact time logged in the 
Batch Log for you. Or if oxygen is dropping below a certain setpoint due to over 
feeding or foaming, you can get an Email send to your normal Email account or to 
your mobile phone, if you have an Email server that will send SMS messages.  
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You can change the default alarm limits by entering new limits in the text boxes for 
low and high alarms. These values are stored in a file, and will be loaded when you 
restart the Fermentor Control Program again. For the Alarm module to work as an 
Email server you need to enter your Email address and also the Email server name 
that you use for your normal Email on your network. You can find the server name by 
looking under Email accounts in your favourite Email client. Use the Test Email 
Communication button to check that it is working. The Email address and server 
name are stored in a file, and will be loaded when you restart the Fermentor Control 
Program again.  
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Option settings 

In this window you can enter your fermentor specific data to fit your setup. All these 
settings are saved in the Windows registry and thus should only need to be set once or 
when ever you change you setup.   

In Fermentor Type you can select your default fermentor type and the default serial 
communication port. NOTE: Currently, only B. Braun BioStat and New Brunswick 
BioFlo fermentors are supported, but as others become available these will be 
included. See www.foxylogic.com for more information. In Fermentor Type you 
can also select the data sampling rate which defines how often process values are 
collected from the fermentor and stored in the database.  

In Vessel and Supply Tank Settings you can enter the volumes of your default 
fermentor and supply tanks. Furthermore, you can set your default batch start-up 
volume, which will then be the default value in the input box that is shown when you 
begin a fermentation run. Setting these values accurately will give you a better 
synoptic window where the live process values are shown, as calculations are based 
on these values.   

In Off-line Data Types you can change the names of the three off-line data fields, 
which are supported by the database. By doing so, you can have a better description of 
the data and its format that has to be entered. Please note that the underlying database 
fields are not changed and should like all field names be left like they are if you use 
Access to manipulate your process data.  

License Key is not in use at the moment, but may become a future feature , if false 
Email registrations become a problem. The program is freeware to the benefit of all. I 
use addresses to send update information but also ask for support information. Email 
addresses are not given to third parties.   

http://www.foxylogic.com



